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Bridging Analog Audio
to the Magic of Digital
By John F. Catalano

I

magine you’re trying to monitor that
rare shortwave DX catch or Dxpedition
station, only to have signal fading, atmospheric crashes and station interference make
it impossible! It’s happened to all of us. But a
program called Diamond Cut Seven (DC 7)
could possibly save the day by digging the
station’s audio out of the muck. Not a recording of it, but in real time, using the audio from
your radio.
“Magic,” you say? Perhaps. But as the late
Arthur C. Clarke postulated in his third laws
of prediction, “Any sufficiently advanced technology is indistinguishable from magic.” So,
let’s take a glimpse behind the wizard’s curtain
to see and, of course, hear if this monitoring
“magic” is real.

❖ Our World
Humans are analog creatures. A continuous range of sensory intensities stimulates our
senses. For example, our tympanic membrane,
the eardrum, responds to air pressure waves,
which we called sound. We catalog sounds as
louder or softer and higher or lower in pitch.
Our sensory perceptions are all relative, based
on our recent experiences. This is the essence
of our analog world.
We don’t see, feel, taste, or hear in discrete steps of ones and zeros. But, these are
the makings of the digital world where signals
are absolute and do not rely on relative levels.
However, once analog signals are converted
into the digital domain, they can be manipulated, enhanced and then reconstituted in ways
that we analog beings can only conceive of as
magic.

❖ DV Seven
DC Seven (DC 7) from Enhanced Audio
(www.Enhancedaudio.com) bridges the gap
between the two worlds, analog and digital, in
the audio spectrum. It works all the magic that
the digital world can muster, using powerful
digital signal processing algorithms. And then
DC 7 returns the data back to the analog human
audio interface, which is sound.
DC 7 is not cheap at $159 (on line) and
$199 on CD. But, based on its feature set, it
is comparable to competitor software suites
which start at $799 and go way, way up from
there. So, if it works as advertised, DC 7’s price
is a steal for audiophiles, hams, radio monitors, professional audio studios, and, shall we
say, government work? We may not be able
to evaluate the package to the satisfaction of
all these groups, but let’s see what we can do
with DC 7 as radio monitors with little or no
professional audio processing experience.
It is said that necessity is the mother of
invention. DC 7, developed over a 13-year
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Figure 1 – DC 7 Main Screen – Gateway to audio file magic – command bar menus at top &
level meters on right.
period, is the brainchild of two recording
engineers. They had a goal to build an audio
archive using old recordings, which in many
cases were almost unintelligible. In order to
restore these audio recordings, they created the
first version of this program. Over the past year
it has been updated, improved, and developed
into its present version, DC 7.
DC 7 can optimize audio intelligibility
and in many cases make it understandable. The
list of applications includes audio recordings
from vinyl records (anyone remember those?),
magnetic tape recordings, compact disks, and
computer files, such as wave files. However,
its use is not limited to just pre-recorded audio.
Using the “Live” feature of DC 7, audio from
live sources such as telephone and (yes!) radio
receivers/ham transceivers can be restored in
near-real time.
In this two-part series we will cover the
capabilities, installation and basic functions of
DC 7. Once we become familiar with DC 7, we
will perform detailed applications covering a
number of the above uses, including, of course,
live radio and ham monitoring applications.
So you can actually hear and judge for
yourself the difference DC 7 makes, we will
post the “before” and “after” audio files of each
our endeavors on the MT website.

❖ A LOT to Cover
Keep in mind that DC 7 is a very powerful
program with filter presets, multi-filter combinations, audio preamps with various builtin equalization curves, comprehensive tube
amplifier simulations and much, much more.

The User’s Manual for DC 7 is a whopping
450+ pages – of which 367 pages are directed
to instructions and applications of the program.
A 30-page section includes useful general
audio information including a rich glossary of
terms, and 50+ pages of the manual contain a
collection of not-to-be-missed standard charts,
graphs and very interesting audio information.
Clearly we can’t begin to cover what DC
7 can do in detail. Instead, we’ll do our best
to give you a flavor of DC 7’s basic operation
for radio monitors and hams in this first two
articles.
Okay, so let’s get started down the road
of audio restoration magic.

❖ What is DC 7?
The program is actually a collection of
DSP (Digital Signal Processing) routines.
Some simulate audio filters of various types.
Others perform specialized amplification functions. Many of these have complex characteristics tailored to audio applications. High levels
of audio customization for specific applications
are achieved using multiple filters and function
blocks. And, getting more sophisticated, these
can be chained together in various sequences.
(Now you can see why the manual is 357
pages.)
But how is an audiophile, radio monitor
or ham to know which DSP routines to use
and how to put them together? DC 7’s answer
is simple. You don’t have to know anything
about DSP routines. The creators of DC 7
have arranged the menu-driven program by

audio application using preset filters. Over
800 preset filters are included. However,
for the adventuresome and experienced, DC
7 provides the user control over just about
every filter parameters! This allows detailed
customization to the user’s exact and specific
audio needs.
In most cases we’ll follow the simpler
preset route for this article. For example, if you
have a recording made from a vinyl record, you
can probably hear clicks, pops and other noise.
The clicks are the result of surface scratches.
The pops are the result of static discharge,
not unlike atmospheric noise (QRN) heard on
shortwave signals.
We’ll see how, with just three mouse
clicks on DC 7, we can greatly reduce or even
remove these annoying noises complete. That’s
what I call simple!

❖ System Requirements
Clearly these powerful DSP routines
require more than a 486 processor, but, surprisingly, not much more. DC 7’s minimum
PC processor requirement is the eight-year-old
750 MHz Pentium, not exactly state of the art.
(More like state of the ark.) However, if you
are going to string together multiple functional
blocks or use the Live feature, a faster PC may
be required.
To start, a reasonable quality 16 bit sound
card with line level inputs is needed. Since we
are definitely going to use the Live feature for
real time radio monitoring, a full duplex sound
card is required. A full duplex sound card allows playback and recording of an audio signal
at the same time.
Don’t forget lots of hard drive space. The
program occupies about 20 MB. But you will
need 2.5 GB for each full audio CD you intend
to create: At a sample rate of 44.1 kHz, a stereo
recording uses 10.5 MB of hard drive space per
minute. And finally, since the program comes
on CD, a CD ROM player is required. If you
intend to register the program via the Internet,
an Internet connection is needed.
DC 7 runs on Windows XP with the SP3
update and 512 Mbytes of RAM, or Windows
Vista with 1024 Mbytes RAM. For XP users,
DirectX 5.0 or higher is required.
We used a Toshiba A135-S2276 laptop with a 1.6 GHz Duo Core T2060 CPU,
2048Mbytes of RAM and a Vista Home Basic
operating system. The Vista OS has DirectX
10 installed and our hard drive had 22 GB of
free space. The laptop has an IXP SB450 High
Definition Audio Controller using the Realtek
High Definition Audio Suite. This sound card
combo performed perfectly with DC 7.

❖ Install, Register, Configure
Installation from the CD is easy and takes
about three minutes. Once the program loads,
the unique serial number must be entered,
along with the owner’s name exactly as it was
entered when the program was purchased.
Finally, we must register the program with
Diamond Cut before the program will run. If
you have an Internet connection, the program
can do the registration automatically. Email

or telephone registration is also
possible.
We’re almost ready to run
… Next, turn off all background
tasks on the PC. If you have a
screen saver enabled, turn it off.
These tasks may interfere with the
DC 7’s operation by competing
with it for the processor’s attention. Now we’re ready to go.

❖ Running DC 7
You might think that accessing all the power, features, and
functions would require tons of Figure 2 - Virtual phono pre-amp in the default preset ready
complex menu screens. Not so. to play/record vinyl LP
The authors of DC 7 have done
a good first example.) We start by attaching a
a great job creating a simple user gateway, as cable from the line output of our stereo to the
seen in Figure 1. The Command Icon rows can line-in of our PC’s sound card. Alternatively,
be seen at the top of Figure 1. Level meters are using DC 7’s Virtual Preamp and adding gain,
displayed vertically on the right side. Signal we can go right from the turntable outputs to
waveform display and function block applica- the sound card. The Virtual Phono Pre-Amp is
tions take place in the center in the screen.
shown in Figure 2.
The User Manual is very well written and
Notice the wide range of preset choices
takes the reader from basic concepts to full that are available, as seen in the open box at
applications. It is rich with audio theory and the bottom. You can choose one of these presets
is an excellent “everything you want to know” or set your own bass mid and high tones, along
audio filter resource. It is well worth the time with the other preamp settings. You can then
to read this voluminous document. But with our save it as a new preset if you wish.
limited time we are going to use an OJT, On the
We’re going to go simple and pick the deJob Training approach. We’ll start each of our fault: flat tone levels, Preamp Standard RIAA,
work-through examples by stating a particular Record Type RIAA Vinyl LP/45, Rumble Filter
audio need that requires our help. Here are the Off, and Volume Control set to mid range.
three we will cover in these two articles:
Next, we play our record selection and
have DC 7 save it as a “Source” file in the
A scratched and worn vinyl record of music
wav format. We will limit the selection time
with clicks and pops.
to about 30 seconds to make it easier for you
Recording of audio (voice) from a receiver, at a
to download from the MT website. We have
very low level that is barely intelligible.
named this Vinyl 1 Source.wav
Live audio (voice), from a SWL or Ham receiver
with signal fading, atmospheric noise QRN
Now display the Source file by selecting
and signal interference QRM.
“Open Source” under the “File” menu. Figure
3 is the resulting display, showing the audio
Our first project will provide a very simple waveform and the elapsed playtime in seconds
learning exercise. This will be useful to learn at the bottom. Notice that our audio piece starts
first principles, but will also appeal to the vinyl at approximately 3 seconds into the recording
worshipping audiophiles among us. Then we and ends at 30.6967 seconds.
will build on our experience and advance to
Pressing the Space bar starts and stops the
enhancing a recording of a signal made from playback of the opened file, which can be heard
a shortwave broadcast. And finally, we’ll take on the PC speakers. A vertical line marker
on the task of cleaning up live audio taken right travels across the waveform from left to right,
from a receiver/transceiver’s speaker output, for indicating exactly what we are hearing at any
real-time audio restoration.
instant. In Figure 3 you can see the marker just
As we work though each example, we’ll left of the 23.4996 second timing mark.
learn the basics of capturing the
audio, filter and function block
choices, application of the blocks
to audio, listening to the modified
audio, possible re-application,
and finally, saving the restored
audio. Again, keep in mind that
we are just touching the surface
of what DC 7 can do.

❖ Starting Slow
Let’s try a relatively simple
task to start. How about cleaning
up the music from an old Korean
vinyl recording? (Okay, so it’s
Figure 3 – Displaying & playback of our captured 30.6967
not exactly U2. But the audio was
seconds of Korean music from LP. Notice the playback mark
provided by Diamond Cut and is
to the left of 23.4996 seconds.
June 2008
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html. Then download and listen
to the two files using Windows
Media Player or other player
that is wav compatible. Now you
can be the judge of how much a
difference applying the simplest
method of DC 7 restoration has
on the audio. Remember, we did
this with just three clicks and
even less audio technical knowhow!
Okay, let’s review: We
have now learned how to capture
and store audio sources, apply a
Figure 4 - EZ Impulse Filter about to clean out the crackle “magical” filter with one click,
listen to the “cleaned” audio and
and pops with one click!
store the cleaned audio in a destination file. These processes will be useful in
our other DC 7 projects.
❖ EZ Does It
There are many, many different methods
of restoring vinyl LP audio in DC 7. We are go- ❖ Want More Control?
ing to use the very simplest for our first project.
Don’t we all? But, if it’s more filter conIn fact, it is called the EZ Impulse Noise Filter. trol that you want, the Expert Impulse Noise
Access it from the first Icon on the left of the Filter is for you. This can be used instead of
second row of icons in Figure 3: Click on the the EZ version used in the above example. The
letters EZ. We can also get to the EZ Impulse Expert version provides much greater control
Noise Filter via the dropdown Filter menu at of all filter parameters. However, given all the
the top of the display.
possible combinations of parameter settings,
With the Source file (Vinyl 1 Source. taking the Expert route could be an all-day
wav) displayed, click the EZ Impulse Filter endeavor without more of an understanding of
icon. Now the EZ Impulse Filter Box will be the filter operations. That said, for those users
displayed as shown in Figure 4. If the user hits who either have the filter design knowledge or
the F1 key while a functional block box is be- who invest time in reading the DC 7 manual,
ing displayed, instructions for its use will also the Expert Impulse Noise Filter will provide
be displayed. This makes using the Help file a a clean result with minimum reduction of the
pleasure instead of a chore.
audio’s fidelity.
In order to really scrub the audio clean, we
The important point here is DC 7’s Simple
have selected one of the filter’s sixteen presets, and Expert approach. Most all features and
“Aggressive Scratch and Crackle Remover.” function in the program can be used at either
Notice in Figure 4, the three buttons on the level, depending on the expertise and/or critical
right side of the filter box. The Preview button need of the user. This is an excellent concept
allows the user to hear the results of applying that the authors of DC 7 have consciously
the chosen filter preset or custom settings.
designed into DC 7. Other software writers
If it results in sound to your liking, the should follow this approach.
Run Filter button does the job and places it in
a Destination file. Using the “Save Destination
As” under the File menu, the filtered/restored ❖ A Simple Radio Application
Since you are reading this in Monitorfile has been resaved as Vinyl 1 EZ Impulseing Times, you’re all about radio. Before we
Filter Aggressive S&P.wav.
get really fancy and go live, let’s try a simple
application of DC 7 on a file recorded from
❖ Hear for Yourself
shortwave.
Go to this column’s website at www.monIf you are following along using the wav
itoringtimes.com/html/computers-radio. files on the MT site, download and play Radio
Recording 1.wav. This is an
audio file of a German language
shortwave news broadcast. You
will hear two major problems
with the signal. The modulation
of the female announcer is very
low, while the background radio
noise is quite high. While keeping it very simple, what can we
do with DC 7?
DC 7 power comes from
its ability to combine a number
of filters and functional audio
blocks into an audio processFigure 5 – MultiFilter windows processing our shortwave ing chain. Each filter/block is
recording. Notice at the top the functional blocks in process- independently customizable in
its audio parameters and relative
ing chain
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placement in audio processing chain. DC 7 calls
this feature “Multi-Filter.”
Start by opening our source file Radio
Recording 1.wav using the File menu. Next,
select MultiFilter from the Filter menu on the
top Command line. We’ll cover this powerful
feature in more depth in Part 2. For now, let’s
just select the MultiFilter preset titled “Live
Mode Demo Cleanup – SW Radio.” Figure 5
is a close-up of the MultiFilter window.
Notice the top line. Here the audio processing chain and all of its functional blocks are
displayed. Remember, this is the configuration
for the preset we have just chosen. Starting from
the left side of the top diagram in Figure 5, we
see that the input first goes to a Continuous
Noise 1 block. This filter is used to remove
the white noise hiss on our signal. The “1”
indicates that it is the first functional block in
our processing chain.
From Figure 5 we see that a Median filter
is next in line. This filter reduces small impulse
noises, such as crackle or (on a radio signal)
atmospheric static discharge noise.
Then comes a functional block with the
pugilistic sounding name “Punch & Crunch.” It
is actually a multi-channel dynamic compressor
and expander: hence the name. Here, a weak
low-level audio signal, such as we have in our
example, is “punched” to a higher level. Don’t
be confused: this does not simply increase the
gain of the audio. If that were all it did, we
would increase the level of the background
noise as well and achieve very little. Instead,
this block picks the program out of the noise.
Then it just expands the program material (for
our example, a female voice), leaving most of
the noise down in the dust.
The fourth and final block, Graphical
Equalizer, acts as a sophisticated tone control.
Now we’ll run the filter chain and save the
destination file.

❖ So, How Does It Sound?
Go back to the MT website. Download
and listen to the file titled Radio Recording 1
MultiFilter Preset LMDC-SW Radio.wav.
Now re-listen to Radio Recording 1.wav.
What do you think?
There is no question that this is a great
improvement. The noise is way down and the
voice has been pulled out of the mud. Again,
stop and think. We have done all this with just
a few mouse clicks and NO knowledge of audio
processing. That’s quite a feat for us, and quite
a tribute to DC 7.

❖ Next Month – Live
There is an old adage in the audio business.
“No one hears or likes the same things. That’s
why God created tone controls.” Next month
we’ll dig a bit deeper into the filter blocks and
see (i.e., hear) the effect of various filter adjustments. In fact, we’ll do a little tweaking of our
own and re-do our second example above.
So far, we have DC 7 working on recorded
files. How well will DC 7 work in real time with
audio from our shortwave receiver? Find out in
Part 2, next month.
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s we saw last month in Part 1, Diamond
Cut 7 (DC7) is an audio restoration program suite that can really clean up audio
recording. Using DC7, noise and background
hum alike can be dynamically filtered out. Then,
using other DC7 functions, the resulting audio
can be further enhanced, digging it right out of
the “dirt” and making the recorded audio very
intelligible.
But, DC 7 claims to be able to work its
magic on live audio signals from our receivers
in real time. No recordings here! Is this possible?
Can we really take a live signal in the mud of
atmospheric noise (QRN) and signal fading and
move it from un-intelligible to intelligible? In
Part 2 we will attempt to answer these questions.

❖ Quick Review
DC 7 has three basic parts: first is digitizing
the analog audio signal. Next, its many, many
functional blocks that the user can string together to perform very complex audio functions
in the digital domain. And finally, DC 7 returns
the digital audio to analog so we can hear it.
Sounds simple, but as we saw in Part 1,
the eight hundred or so functional filter blocks
that DC 7 provides can do virtually anything to
recorded audio, if we take the time to learn how
or if we are audio experts. DC 7 also provides
easy to use “canned” routines for us casual users
that choose the correct function blocks for our
required application.

❖ Hardware Required
DC 7 runs on Windows XP with the SP3
update and 512 Mbytes of RAM, or Windows
Vista with 1024 Mbytes RAM. For XP users,
DirectX 5.0 or higher is required. A full duplex
sound card that can record and play at the same
time is essential.
We’ll use the same Toshiba A135-S2276
laptop with a 1.6 GHz Duo Core T2060 CPU,
2048Mbytes of RAM and a Vista Home Basic
operating system. One difference from Part 1 is
that we have now installed the SP 1 upgrade to
the Vista OS. To date, I have found no problems
with previously installed programs running
under Vista SP 1.

❖ Receiver Hardware
Any shortwave receiver or scanner audio
output will work. We will use the audio output
of the venerable Icom IC-R71 shortwave receiver. The R71’s front panel Line-Out jack is
connected to the PCs audio card’s Line-In.

Using Diamond Cut 7 – Part 2
Live Audio Clean-up
By John F. Catalano

❖ The Multi-Filter
Okay, so now that we have
audio, what is the easiest way to
use DC7 to filter the audio? The
answer lies in the use of the DC
7’s Multi-Filter, see Figure 1.
This function allows the user to
“stick together” any of the filters
included in the program. But DC7
does not stop there. The user can
choose the sequence in which the
filters are used simply by dragging and dropping them into the Figure 1-2 Diamond Cut 7 (DC7) Multi-Filter that we customorder we need. Each filter section ized for live shortwave monitoring.
can then be customized to our
of frequencies.
specific monitoring conditions.
I used an empirical method of adjusting the
We can hear the effect of each individual
filter section on the signal by using the filter’s slider controls and then listening to the result via
“Preview” button. In a similar manner, we can the “Preview” button. This was repeated a numhear the effect of the whole string of filters via ber of times until the resulting signal sounded
the best – not easy with an ever-changing live
the Multi-Filter’s “Preview” button.
DC7 provides users with a number of off-air shortwave signal. But you can get a good
ready-made multi-filters. The Multi-Filter that result after a few tries.
we created, shown in Figure 1, is very simple,
having only three filter sections. We have tailored ❖ Noise and Lots of It!
each filter section and saved the result as “C&R
In the next filter section we will try to filter
SW Off Air Filter 1.” Let’s look at each section out more noise. The Continuous Noise filter is
in our simple Multi-Filter.
one of the most important in cleaning up SWL

❖ Starting at the Beginning

signal.
The User Manual’s tutorial on this filter
suggests the following set-up procedure, followed by spending “… about an hour playing
around with it in order to become familiar with
its behavior.” To give you an idea of the filter setup procedure, below is an abbreviated version
of what is described in the DC 7 User manual.

All the files mentioned in this article can
be found at www.monitoringtimes.com/mtsubscriber (required password found in current
issue) and you may listen to them with Windows
Media Player or any audio player capable playing
“.wav” files.
Start by playing our original, live, off air
signal, OFF_AIR_Orig.WAV. You can hear that Continuous Noise Filter Procedure
this signal has two severe problems: high and (condensed by J. Catalano)
varying background noise levels and signal 1. Highlight a quiet portion of the Source .wav
file.
fading due to propagation. Not easy problems to
2 With the left mouse button, click on “Filter.”
solve. In fact, where the signal has faded below 3. Next, click on “Continuous Noise.”
the noise, no program, not even DC 7, can do the 4. When the Continuous Noise Dialog Box apimpossible and recover the audio.
Perhaps we can make parts of this
signal very difficult signal more
“listenable.”
The first filter section seen
at the top left of Figure 1 is the
“BandPass1.” The “1” denotes
that this is the first filter section
of our multi-filter. If we double
left-click on the BandPass filter,
Figure 2 is displayed. From here
we can adjust the filter’s parameters. In the BandPass filter we
will try to remove some noise Figure 2-2 Customizing the Bandpass Filter to our condisignals outside the speech range tions.
July 2008
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Figure 3-2 The Continuous Noise Filter hearing and learning our signal
pears, click on “Sample Noise.”
5. A graph will appear showing the Amplitude (in
dB) versus the Frequency of the .wav file noise
floor.
6. The measured sample noise spectrum is shown
in red. The noise threshold value vs frequency
is in blue.
*
7. To change the graphical threshold contour, follow the procedure outlined in steps 7 through
10. Using your mouse, place the pointer on the
left-most blue threshold marker on the graph
(one of ten blue dots).
8. Depress the left mouse button and move the
dot either up or down so that it remains somewhere above the red line graph at the bottom
end of the spectrum.
9. Move the next blue threshold marker just to the
right of the first one, and using the mouse, set
it somewhere above that particular frequency
on the spectrum graph.
10. Repeat process until all ten threshold markers are located somewhere above the “noise
floor” graphical representation of your .wav
file. The blue line should be located above
the red line at all frequency locations. The
best contour can only be achieved by moving
both the markers along the vertical axis and
the horizontal (frequency) axis.
*
11. Set the “Attack” time initially to 25 milliseconds.
12. Set the “Release” time initially to 50 or 100
milliseconds. (The “Release” time constant
should always be set longer than the “Attack”
time constant for a realistic sounding operation
of the filter.)
13. Set the “Attenuation” control initially to 10
dB. (Higher numbers results in higher levels of
noise reduction.)
14. Highlight the portion of your .wav file on
which you desire to apply the Continuous
Noise Filter.
15. Run the Filter.
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16. Play the section that you have just processed,
and determine which parameters need modification.
17. When you are satisfied with the results, rerun the .wav file

As you can now appreciate, although DC7
has many pre-loaded filters and multi-filters,
special situations require time and effort for good
results. Figure 3 shows our Continuous Noise
filter in the process of being set up.

❖ Punch & Crunch

monitoring conditions, we can do some live off air
listening with DC 7’s assistance.

❖ A Tough One
You can hear the results for yourself. Listen
again to the unfiltered signal at the above MT link.
Now go to OFF_AIR_FILTERED.WAV and listen
to the resulting multi-filter signal. Then judge for
yourself. I think you will find parts of the filtered
signal have been greatly improved, while others
parts are just asking the impossible.
We can see the results in Figure 5. The top
graph is the off air input signal. Notice the wide
horizontal area in the center of the graph. This is
our signal with all of its noise.
Now take a look at the bottom graph. Notice
that the broad wide swath is gone, replaced with
spikes, which in most cases corresponds to voice

This describes what I feel like I’ve been
through after writing a piece on a complex topic!
But in this case it is also the name of the DC7 filter
that tries to compensate for the wild signal fading
on our signal. As we said, realistically no software
can recover audio that just is not there! And for part
of our signal, the fading is so severe the
signal is gone completely.
Figure 4 displays the P&C filter in
operation. Notice that we have broken the
audio into four distinct frequency bands:
0 to 294 Hz, 294 to 2454 Hz, 2454 to 6932
Hz and 6932 and higher. The red lines
indicate at what level the “Expander” or
amplification will take place.
Since most human voice lies in the
frequencies between 300 to 3000 Hz the
red line has been set at zero in this range.
This means that expansion/amplification
takes place at all input levels for these
frequencies. The effect is to amplify
the voice frequencies, leaving the noise
frequencies behind at a lower level.
Now that we have the all the filter Figure 4-2 Punch & Crunch Filter. Notice the four
elements set up for our terrible shortwave distinct audio bands we have created

the worst I have experienced in my 45 years of
SWLing! However, no one can ever accuse this
writer of choosing examples that make his job
easy.
But to be fair to DC 7, let’s see what it can
do with the very hard, instead of the impossible. We have made a file of just the last part
of the intercept. This is the part that has a male
announcer with lots of noise on top of him. You
can hear the original MAN_ORIG.WAV
Now listen to MAN_Filtered.WAV. I think
you will agree that DC7 really cleaned up this
signal and made it listenable. You can listen to
a third example of “before” and “after” files by
listening to EX2_Orig.wav and EX2_Filtered.
wav, respectively.
We found that DC 7 operated the same
when used on live audio or audio files. However,
slower PC processor may cause these two modes
to operate very differently.

❖ Precious Gems

Figure 5-2 Seeing is believing! Top graph is as received off air. Bottom is put through our Multifilter. Notice the “thinning” of the bottom trace.
modulation. However, where the signal fades completely, relatively wide regions are visible. Since
the voice signal is gone, the program is trying to
still find and expand it. The result is amplified
noise.

❖ A Fair Chance
Again, the signals we attempted to clean up
had high levels of noise (QRN) and deep signal
fading, a very hard combination of problems.
The current shortwave conditions are some of

Diamond Cut 7 can be downloaded from
www.Enhancedaudio.com for the price of
$159. Or call toll free 866-260-6376 to order
over the phone. An excellent training DVD,
which walks the user through many uses of DC
7, is available. A download bundle of the DC7,
PDF help file, plus a mailed training video (no
charge for shipping) is available for $188.
If you do any music restoration, DC 7 is
a must. For voice and monitoring applications,
with reading, practice, and patience, DC 7 can
yield very good results for both “live” and stored
audio.
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